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1 Introduction 

This document will describe how to use MindManager 8 for Windows with Microsoft 
SharePoint 2007 server. This document will cover the following topics: 

- Adding a MindManager map file to your SharePoint document repository 
- Check out MindManager Map Files with MindManager 8 
- Check out MindManager Map Files with SharePoint 
- Using SharePoint Hyperlinks in MindManager 
- Map SharePoint Environment with File/Folder Explorer Map Part 
- Embed MindManager Clickable Imagemap in SharePoint Page 

This document assumes the following: 

- MindManager 8 
- Microsoft SharePoint 2007 Server 
- Microsoft Internet Explorer 6 or greater 
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2 Using MindManager 8 with Microsoft SharePoint 

2.1 Add MindManager Map to SharePoint Repository 

The following steps assume that you have already created a map and saved it to your local 
file system (the initial map file must be uploaded to the SharePoint server versus created 
directly on the SharePoint server). 

1. Login to your Microsoft SharePoint server. 
2. Click on the Document Center. 
3. Click on the Documents link in the Site Hierarchy pane on the left of your screen. 

 

 
 

4. Select Upload Document from the Upload Menu. 
5. Press the Browse button on the Upload Document page. 

 

Documents Link 

Upload Document 

Documents Center 
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6. Using the standard Choose File dialog box (browser), select the MindManager map file 
that you want to upload to the SharePoint server. 
 

 
 

7. Press the Open button. 
8. Enter any comments in the in the Version Comments field. 
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9. Press the OK button. 
10. At this point, the document has been uploaded to the SharePoint server, but the 

document is not yet checked in. 
 
NOTE: If the document is not checked in, other SharePoint users cannot make edits to 
the MindManager map and will only be able to view in a read-only mode. 
 
Enter a meaningful name or description for your document in the Title field and press 
the Check In button. 
 

 
 
Your MindManager map file has now been successfully uploaded and checked into the 
Microsoft SharePoint server and is ready for use. 

2.2 Edit MindManager Map File Stored in Microsoft SharePoint 

Among other things, Microsoft SharePoint is designed to facilitate document collaboration 
between users. As such, it requires that a user “check out” or “lock” a document for editing. 
If a document is not checked out, the file stored in SharePoint cannot be edited and any 
changes must be saved to your local file system. 

Check Out MindManager Map Files with MindManager 8 

The following procedure describes how to check out a MindManager map file from within 
MindManager 8: 

1. Start MindManager 8 
2. Select Open from the Application menu. 
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3. Navigate to your SharePoint environment by: 
a. Enter the URL for your SharePoint environment in the File Name field and press 

the Open button. 
 

 
 

b. Press My Network Places and locate your SharePoint environment (requires that 
you or IT administrator have added your SharePoint environment to your 
Network Places). 

4. Locate the desired MindManager map file (*.mmap) and press the Open button. 
5. If prompted, enter your SharePoint credentials in the Connect dialog box.  

 

 
 
If you have selected Remember my Password previously, you will not need to enter your 
credentials and can skip to the next step. 

6. If you want to edit the selected map, you will need to press the Lock button when the 
Lock Map dialog appears. 
 

 
 
If you you press the Lock button, you will check out the file from the SharePoint 
repository and can make edits to the file. During this time, other users will not be able 
to modify the selected file. 
 
If you do not need to make edits to this file, press the Don’t Lock button to open the 
map in read-only mode, allowing other users to make edits to the file. 
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Check Out MindManager Map Files with SharePoint 

The following procedure describes how to check out a MindManager map file from the 
directly from the SharePoint server: 

1. Login to your Microsoft SharePoint server. 
2. Click on the Document Center. 
3. Click on the Documents link in the Site Hierarchy pane on the left of your screen. 
4. Hover your cursor over the MindManager map file that you want to edit. 

 
When you hover over the file, a pull-down menu will appear. 
 

 
 

5. Click on the pull-down menu and select Check Out from the pull-down menu. 
 

 
 
The file icon in the SharePoint window will now appear with a green box and an arrow 
( ) to indicate that the file is currently checked out. 
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6. Click on the name of the file that you want to edit. 
 

 
 

7. You will be prompted with the following message: 
 

 
 

8. Press the OK button to continue opening the MindManager map file. 

Edit MindManager Map File 

Once you have checked out and opened a MindManager map file from your SharePoint 
server using the procedure described in the previous section, you can work with the 
MindManager map file normally (as if the file were on your local or network file system). 

While the map is checked out to you, other users will not be able to modify the file stored 
on the SharePoint server and will only be able to open the file in a read-only mode. 

When you have completed making changes to your MindManager map file, please 
complete the following section to check it back in. 

Check In a Modified MindManager Map File with MindManager 8 

The following procedure describes how to check in a MindManager map file directly from 
MindManager 8 after you have modified it: 

1. Save your modified MindManager map file. 
2. Close your map file by selecting Close from the Application menu. 
3. When prompted, press the Yes button to unlock the file. 
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Pressing the Yes button will check the file back into SharePoint making it available to 
other users. 

Check In a Modified MindManager Map File with SharePoint 

The following procedure describes how to check in a MindManager map file after you have 
modified it: 

4. Ensure that you have saved and closed the modified map file in MindManager. 
5. Return to Microsoft SharePoint and navigate to the Document Center | Documents 

directory. 
6. Hover your cursor over the MindManager map file that you want to check back into the 

SharePoint server. 
 
When you hover over the file, a pull-down menu will appear. 
 

 
 

7. Click on the pull-down menu and select Check In from the pull-down menu. 
8. Select the type of revision you want to apply to the modified version of the document by 

selecting of the three radio-buttons (Minor, Major, or Overwrite Current): 
 

 
 

9. Enter any comments for this revision in the Comments field. 
10. Press the OK button. 

The modified map file is now checked in and available to other users for editing. 
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2.3 Using SharePoint Hyperlinks in MindManager 8 

Since Microsoft SharePoint is a web application, linking to files and folders within 
SharePoint is identical to adding a hyperlink to any web page. The following sections will 
provide some guidance on adding SharePoint hyperlinks to your MindManager map. 

Copy SharePoint Document Hyperlinks 

1. Login to your Microsoft SharePoint server. 
2. Click on the Document Center. 
3. Click on the Documents link in the Site Hierarchy pane on the left of your screen. 
4. Right-click on the name of the file that you want to link to. 
5. Select Copy Shortcut from the pop-up menu. 

 

 
 

6. Complete the steps listed in the “Insert Hyperlink into MindManager 8” section below. 

Copy SharePoint Folder Hyperlinks 

1. Login to your Microsoft SharePoint server. 
2. Click on the Document Center. 
3. Click on the Documents link in the Site Hierarchy pane on the left of your screen. 
4. Right-click on the name of the folder that you want to link to. 
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5. Select Copy Shortcut from the pop-up menu. 

NOTE: You can also right-click on the Documents node in the Site Hierarchy pane on the 
left side and selectd Copy Shortcut to create a hyperlook to the root Documents folder. 

6. Complete the steps listed in the “Insert Hyperlink into MindManager 8” section below. 

Insert Hyperlink into MindManager 8 

After you have copied the hyperlink for either a file or directory, complete the following 
steps to insert the hyperlink into your MindManager map. 

1. Verify that the map you want to add the hyperlink is opened in MindManager 8. 
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2. Right-click on the topic (node) that you want to add the hyperlink to. 
3. Select Paste | Paste Hyperlink from the pop-up menu. 

2.4 Map SharePoint Environment with File/Folder Explorer 

MindManager 8 has the ability for you to visually map your SharePoint environment by 
using the File/Folder Explorer map part. 

NOTE: The MindManager 8 File/Folder Explorer requires that your SharePoint environment 
has been added to your My Network Places. 

Map SharePoint 

1. Press the Insert in MindManager 8 and press the Map Parts button. 
2. Select the File Explorer itemin the Map Parts task pane. 

 

 
 

3. Drag the desired File Explorer part into your map: 
• All Files & Folders: Maps both folders (and sub-folders) and files for selected 

path. 
• All Files: Maps files contained in selected path. 
• All Folders: Maps folders (and sub-folders) for selected path. 
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4. Expand your My Network Places in the Browse for Folder dialog box. 
 

 
 

5. Select your SharePoint environment or sub-directory within your SharePoint 
environment. 

6. Press the OK button. 

NOTE: You can now add topic formatting, notes, attachments, hyperlinks, and images to 
your mapped SharePoint environment. 

2.5 Embed Mindjet Player File in SharePoint 

MindManager 8 provides you with the ability to generate a Mindjet Player file in the Adobe 
Flash (SWF) format, making it a natural fit to display SharePoint environment. The Mindjet 
Player file is a read-only, yet interactive and dynamic map providing your SharePoint users 
with the ability to interact with mapped content from within the SharePoint environment. 

Generate Mindjet Player SWF File 

1. Open the MindManager map that you want to display in your SharePoint environment. 
2. Press the Export tab. 
3. Press the Export as Mindjet Player button. 
4. Select Mindjet Player Maps – Flash (*.swf) from the File Type pull-down list. 
5. Adjust target directories and file names if necessary and press the Save button to 

generate your Mindjet Player SWF file. 
6. Upload the SWF file to your SharePoint site. 

Add Web Content Web Part 

1. Navigate to the page where you want to add the Mindjet Player file. 
2. Select Edit Page from the Site Activities menu (upper-right corner). 
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3. Click on the Add a Web Part button in an area near where you would like to place the 
clickable imagemap. 

4. Expand the All Web Parts listing of web parts. 
 

 
 

5. Scroll down until you see the Content Editor Web Part (under Miscellaneous). 
6. Enable the Content Editor Web Part checkbox. 
7. Press the Add button. 
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8. Select Modify Shared Web Part from the Edit menu. 
 

 
 

9. Click on the Source Editor button in the Content Editor Web Part tool pane (right side). 
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10. Place your cursor in the Text Entry window. 

Paste the following code into the Text Entry window: 
 
<object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000"  
codebase="http://fpdownload.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#versi
on=7,0,0,0" width="605" height="400" ID="Captivate1"> 
 <param name="movie" value="[URL to Mindjet Player SWF File]"> 
 <param name="quality" value="high"> 
 <param name="loop" value="0"> 
 <embed src="[URL to Mindjet Player SWF File]" width="605" height="400" loop="0" 
quality="high"  
pluginspage="http://www.macromedia.com/go/getflashplayer" type="application/x-shockwave-
flash" menu="false"></embed> 
</object> 
 
The URL should be a fully qualified path to the map file itself, such as: 
 
http://spserver1/Shared%20Documents/Demonstration/SWOT%20Analysis.swf 

 
NOTE: You can also adjust the size of the MindManager window by adjusting the height 
and width tags in the Object tab (near the beginning of the code). 
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11. Press the Save button. 
After the page refreshes, you will see the map image appear in the Web Part container. 
 

 
 

12. Press the Exit Edit Mode link to complete the changes. 
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The Mindjet Player file is now embedded in your SharePoint site. 

 

2.6 Embed MindManager ActiveX Control in SharePoint 

Mindjet offers a MindManager ActiveX control that allows users to view and navigate maps 
hosted on any website, including Microsoft SharePoint, if the user has installed the ActiveX 
control for Internet Explorer. 
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Add Web Content Web Part 

1. Navigate to the page where you want to add the MindManager ActiveX control. 
2. Select Edit Page from the Site Activities menu (upper-right corner). 

 

 
 

3. Click on the Add a Web Part button in an area near where you would like to place the 
clickable imagemap. 

4. Expand the All Web Parts listing of web parts. 
 

 
 

5. Scroll down until you see the Content Editor Web Part (under Miscellaneous). 
6. Enable the Content Editor Web Part checkbox. 
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7. Press the Add button. 
 

 
 

8. Click on the Open the Toolbar Pane link in the new web part. 
 

 
 

9. Click on the Source Editor button in the Content Editor Web Part tool pane (right side). 
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10. Place your cursor in the Text Entry window. 
11. Paste the following code into the Text Entry window: 

 
<object  
  id="viewer"  
  height="400"  
  width="600" 
codebase="http://www.mindjet.com/viewer/ax/en/MjMmViewer.cab#Version=6,1,111,0"   
classid="clsid:4C57C98A-E582-46E4-8FD8-5EBDC94CEA39"> 
<param  
  name="Image"  
  value="[URL to MindManager Map File]"/> 
<a  
  href="?install=viewer"><img src="../../../images/eng/MindManager_viewer_plugin_n.gif"  
  width="419"  
  height="300"  
  class="mapimage"  
  alt="Click on the MindManager map image to install the Viewer and view maps through a 
browser" /> 
</a> 
</object> 
 
The URL should be a fully qualified path to the map file itself, such as: 
 
http://w2kserver-en/Docs/Documents/Marketing/MacTip_AppleScriptExample_20071008.mmap 

 
NOTE: You can also adjust the size of the MindManager window by adjusting the height 
and width tags in the Object tab (near the beginning of the code). 
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12. Press the Save button. 
After the page refreshes, you will see the map image appear in the Web Part container. 
 

 
 

13. Press the Publish button to complete the changes. 
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The MindManager ActiveX control is now inserted into your SharePoint site. 

2.7 Insert Clickable Imagemap in SharePoint 

MindManager 8 allows you to export a map as a clickable image file. This image file along 
with the automatically generated HTML can be inserted into your SharePoint site to provide 
users with a very intuitive and efficient means of navigating to important information in 
your SharePoint site.  

 

Export Clickable Imagemap 

1. Open the map that you want to export in MindManager 8. 



25 | P a g e  
 

©  M i n d j e t  2 0 0 8  
 

 

2. Select MindManager Button | Export | Export as Web Pages. 
 

 
 

3. Select Clickable Imagemap from the Select Web Template dialog box and press the OK 
button. 
 

 
 

4. Specify the folder that you want to save the clickable imagemap (both the image and 
the HTML) in the Export Folder field (press the  button to use the Windows control to 
select an export folder).  
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5. Press the Save button to complete the export. 

NOTE: You may want to press the Customize button and select the Advanced Settings 
tab. You can adjust many attributes, including controlling the image size (Zoom Factor), 
to customize your clickable imagemap export. 

 

Once the export process is complete, several files will be generated in the folder 
specified in step 4 above: 

• Index.jpg: This is the actual image that will be imported into your SharePoint 
site. 

• Index.html: This is a complete web page that contains the image reference and 
the image map information to add hyperlinks to the image (you will 
only import part of the HTML and not the complete file). 

• Index.html.txt: This contains just the map information for the image file. 

Add Clickable Imagemap to SharePoint Site 

1. Login to your Microsoft SharePoint server. 
2. Click the View All Site Content button at the top of the left navigation pane. 
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3. Click on the Pages subdirectory in the Document Library list. 
 
NOTE: If you upload the image to the Images directory, you will need to manually modify 
the automatically generated HTML. If you add to the Pages subdirectory, no HTML 
modifications will be necessary. 

 

4. Select Upload | Upload Document. 
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5. Press the Browse button on the Upload Document: Pages page. 
6. Select index.jpg from the directory where you exported the clickable imagemap earlier 

in this procedure. 
 

 
 

7. Press the Open button. 
8. Press the OK button on the Upload Document: Pages page. 
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9. Press the Check In button on the Pages: Index page. 
 

 
 

The image file has now been added to your SharePoint site. 

Copy Automatically Generated MindManager HTML 

1. Select Start | Program Files | Accessories | Notepad. 
2. Select Open from the File menu. 
3. Navigate to the directory where you exported the clickable imagemap earlier in this 

procedure and open the index.html file. 
4. Press <CTRL><A> to select all contents of the file. 

 

 
 

5. Select Copy from the Edit menu. 
6. Select Exit from the File menu. 
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Add Web Content Web Part 

1. Navigate to the page where you want to add clickable imagemap. 
2. Select Edit Page from the Site Activities menu (upper-right corner). 

 

 
 

3. Click on the Add a Web Part button in an area near where you would like to place the 
clickable imagemap. 

4. Expand the All Web Parts listing of web parts. 
 

 
 

5. Scroll down until you see the Content Editor Web Part (under Miscellaneous). 
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6. Enable the Content Editor Web Part checkbox. 
7. Press the Add button. 

 

 
 

8. Click on the Open the Toolbar Pane link in the new web part. 
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9. Click on the Source Editor button in the Content Editor Web Part tool pane (right side). 
 

 
 

10. Place your cursor in the Text Entry window. 
11. Press <CTRL><V> to paste the HTML that you copied in Notepad earlier in this 

procedure. 
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12. Press the Save button. 
 
After the page refreshes, you will see the map image appear in the Web Part container. 
 

 
 

13. Press the Publish button to complete the changes. 
 

 

The clickable image map is now inserted into your SharePoint site. 


